
    

  

                      

 
 
 
 
 
 

 
    User Guide 

 
 
 
 
 
 
 
 
 
 
 

 

 
EEG Enterprises, Inc. 
586 Main Street 
Farmingdale, New York 11735 
 
TEL: (516) 293-7472 
FAX: (516) 293-7417 
 
 
Copyright © 2015 EEG Enterprises, Inc. 
All Rights Reserved.  



                       

Table Of Contents 

Introduction ______________________________________________________ 2 
Product Description .................................................................................... 2 

Getting Started ____________________________________________________ 4 
System Requirements ................................................................................. 4 
Installation ................................................................................................... 4 
USB Dongle .................................................................................................. 5 

Using Scout _______________________________________________________ 6 
Workflow ..................................................................................................... 6 
Supported Video Types ............................................................................... 6 

Menus and Toolbar Overview ________________________________________ 7 
File Menu ..................................................................................................... 7 
View Menu .................................................................................................. 8 
View Toolbar................................................................................................ 8 

Tabs Overview ____________________________________________________ 9 
Video Tab ..................................................................................................... 9 
MXF Explorer Tab ........................................................................................ 10 
VANC Analyzer Tab ...................................................................................... 10 
Test Results Tab .......................................................................................... 11 

Video Frame Viewing _______________________________________________ 12 
Frames and Scrolling ................................................................................... 12 
Movie Reel/Fast Navigation ........................................................................ 13 
Using Locators ............................................................................................. 14 

Audio Waveform Viewing ___________________________________________ 16 
Waveform .................................................................................................... 16 
Scrub ............................................................................................................ 17 
Audio Tracks ................................................................................................ 17 

Message Panel ____________________________________________________ 18 
Loading Profiles ___________________________________________________ 19 

Profile List .................................................................................................... 20 
Tests ............................................................................................................. 21 
Locators ....................................................................................................... 21 

Output Reports ____________________________________________________ 22 
 

 
Copyright 2015, EEG Enterprises, Inc. All rights reserved. The contents of this manual may 

not be transmitted or reproduced in any form without the written permission of EEG. 
 

The revision date for this manual is July 7, 2015. 



FilePro Scout 
 

 
                                                                        Copyright © 2015 EEG Enterprises, Inc.                                          2 

                                                                                                     All Rights Reserved. 

                       

Introduction 
 

Product Description 
 

A comprehensive QC tool, FilePro Scout allows broadcasters and post production facilities to run 
automated validation tests on MXF AS-02 bundles with speed and efficiency. Manual follow-up 
features are also included, providing intuitive and insightful views into bundle structure, essence, 
and metadata with unique clarity and precision. 
 
FilePro Scout can be utilized by facilities to ensure that MXF AS-02 bundles completely meet 
contribution standards prior to ingest into a play-out library or delivery to distribution partners. 
FilePro Scout flags potential issues with bundle structure, essence, and metadata with precise 
locators and makes each aspect of the file available for detailed manual evaluation, including frame-
by-frame video and audio, raw and decoded ancillary data, detailed closed captioning features, 
categorized metadata, and visualization of the bundle file structure. Additional features and 
benefits of FilePro Scout from EEG include: 
 

• Flexible profile creation to tailor inspection results to custom contribution requirements 
 
• Detects proper wrapping of each media essence component in the bundle 
 
• Detects mismatches between top-level metadata and bundle contents 
 
• Detects common problems with closed captioning and ancillary data 
 
• Decodes and displays JPEG 2000 video essence in all common frame rates 
 
• Visualization of closed captions, AFD, and time code 
 
• Inspection results fully exportable in PDF or XML-based formats 
 
• Inspection locators for flagging specific frames 
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Significant time and cost savings when ingesting MXF AS-02 bundles can be realized by facilities 
employing FilePro Scout. For example, user-defined profiles within Scout establish a delivery 
spec which can be communicated to vendors, allowing them to adjust their encoding workflow 
and deliver error-free bundles moving forward. This process significantly reduces errors that can 
complicate storage, editing and distribution of assets later on. 
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Getting Started 
 

System Requirements 

 Windows 7, Windows 8 
 1GB RAM, 2GB or more recommended 

 
 

Installation 

A Windows installer file (.exe) will be provided via download after purchasing this software. 
Installation steps are as follows: 

 
1. Double click the installer file to begin installation. You should see a license agreement 

screen as shown in Figure 1. 
 

 
Figure 1: Installer Welcome Screen 

 
 

2. After reviewing the terms, check the “I agree” box and click Install to continue with 
installation. 

 
3. Once completed the window will say that installation has been successful. 
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USB Dongle 

FilePro Scout is licensed via a USB dongle similar to the one pictured in Figure 2. The dongle should 
be provided with your software. Insert the supplied dongle into the USB port on the computer – 
this is required for operation of FilePro Scout. 
 

 
Figure 2: USB Dongle 
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Using Scout 
 

Workflow 

Scout provides a powerful set of inspection and analysis tools for AS-02 bundles. A common use 
case would be as follows: 
 

1. Load AS-02 Bundle into Scout 
 

2. Select Profile Desired for Bundle Analysis 
 

3. Run Profile 
 

4. Export Results to XML/PDF File for Record Keeping 
 

 
In addition to loading and running a profile, the bundle can also be inspected manually.  Each frame 
can be viewed and scrolled through. The current frame is displayed along with basic video 
properties in the Video Properties tab. Audio can be set to scrub on each frame.  The bundle's file 
structure can be inspected and verified using the Bundle Explorer.  The bundle's VANC data can be 
stepped through and verified frame by frame in raw hex byte and decoded formats. 

 

 

 

Supported Video Types 

AS-02 bundles with JPEG2000 encoding are supported by Scout 
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Menus and Toolbar Overview 
 

FilePro Inspector has a series three basic dropdown menus and a toolbar located at the top of the 
application window. These menus include File, View, and Help 
                                                                                                                                   

File Menu 

 

Open Movie Open an AS-02 Bundle with the tool. Will be prompted to load profile. 
 
Load Profile Select a profile which will perform an analysis on the bundle which is 

loaded. Item is grayed out if no bundle has been loaded. 
 
Export Current Frame Exports the current frame of video to a full resolution image file format 

BMP, TIFF, JPEG, or PNG. 
 

Export Results Export results to a report in XML or PDF format. 
 
Locators Save/Import Locators to/from various file types. 
 

 Import Locators – Locators can be imported from an EEG Scout 
Locator File (.lctr) or from an Amberfin® QCML File (.qcml). 
Imported locators will be added to the list of pre-existing locators 
(if any). 
 

 Save Locators to File – Locators loaded in the Locator list can be 
saved to an EEG Scout Locator File (.lctr). 
 

 Exit – Exits the application 
  

  
Figure 3: File Menu 
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View Menu 

 

The View menu provides display options for Scout as seen in Figure 4. 
 

 

Timecode Display Toggles between SMPTE timecode display and a frame number 
display. All visual representations of units of the current frame in the 
application are toggled with this control. Frame numbers begin at 1. 

 
AFD Display Toggles on/off the display of the AFD code on each frame of video in 

the application. 
 
Closed Captioning Toggles the display of closed captioning on each frame of video in the 

application. Closed Captioning service channels CC1-CC4 and S1/S2 
can be selected or the display can be turned off completely. 
 

Scanning Mode Toggles between Field and Frame displays. Frame display will display 
complete interlaced frames. Field display will display each frame as a 
series of fields. 
 

Locators Save/Import Locators to/from various file types. 
 
 

 
Figure 4: View Menu 

 

View Toolbar 

 

The View Toolbar, as seen in Figure 5, is a more accessible version of the View Menu options 
discussed on this page. Options include Timecode Display, AFD Display, Closed Captioning, and 
Scanning Mode. The toolbar is always visible in the Scout Window directly under the menus for 
quick toggling between view options. 
 

 
Figure 5: View Toolbar 
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Tabs Overview 
 

Video Tab 

The Video Tab, as shown in Figure 6 is a split screen view. The left side of the split is an enlarged 
render of the current frame, with optional overlays displayed (based on View Settings). The right 
side of the split is a list of video/audio/metadata properties such as: 
 

 Frame Rate 
 

 Scan Format 
 

 Aspect Ratio 
 

 Color Space 
 
 Chroma Sub-Sampling 

 
 Video Component Bit Depth 

 
 Video Average Bit Rate per Frame 

 
 Video Peak Bit Rate per Frame 

 
 Video Codec 

 
 Audio Track Count 

 
 Audio Channel Count (per track) 

 
 Audio Sampling Rate 

 
 Audio Bit Depth 

 
 VANC Data (type/location) 

 

 
Figure 6: Video Properties Tab 
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MXF Explorer Tab 

The MXF Explorer tab provides a tree-view of the bundle structure, as seen below in Figure 7. All 
version, media, and VANC file metadata is viewable in a hierarchical format. Shim and Manifest file 
contents are also viewable. 

 

 
Figure 7: MXF Explorer Tab 

 
 

VANC Analyzer Tab 

The VANC Analyzer tab provides a frame by frame breakdown of the VANC data present in the 
VANC track of the bundle. Each frame is broken down by VANC packet type (DIDSID). When selected 
in the packet list the packet’s contents will be highlighted in a raw hex viewer, as seen in Figure 8. 
The decoded fields of the packet will also be displayed in the window to the right of the packet list 
and hex viewer. 
 

 
Figure 8: VANC Analyzer Tab 
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Test Results Tab 

The test results tab displays the results from all tests included in the current profile. Each test gets 
a pass/fail result and failures are followed by details of each error. 
 

 
Figure 9: Test Results Tab 
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Video Frame Viewing 
 

The Video Frame Viewer provides a means for viewing and scrolling through multiple frames of 
video simultaneously. Frames can be jumped to by timecode/frame number and basic video 
properties are displayed. Locaters can also be added to any frame for easy access and note keeping. 
These features will be described in more detail in the following sections. 
 
 

 
Figure 10: Video Frame Viewing Tools 

 
 

Frames and Scrolling 

The video frame viewer displays 5 video frames simultaneously, as seen below in Figure 11. The 
current frame is in the middle of the frames and is slightly larger to indicate it as such. Dragging 
the scrollbar underneath will update the current frame. Ancillary data such as AFD and closed 
captioning will be displayed on these frames. Double-clicking and frame in the video frame viewer 
will break out the frame into a full resolution image in a separate window for detailed inspection. 
 
 

 
Figure 11: Video Frames 
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Movie Reel / Fast Navigation 

The Movie Reel control displayed in Figure 12 can be utilized for precise navigation forward and 
backward through the video frames, as well as gathering basic information about the timing of the 
video such as in and out points, duration and frame rate.  
 

 
Figure 12: Jump to Frame and Time Info in Movie Reel 

 

 

Jump to Frame A timecode or frame can be jumped to immediately using the input 
box and “Go” button directly to the right of it. The input box will accept 
timecode of frame number formats, depending on the current 
Scanning Mode selected in the View Menu. 

 
Skip Frames The video frames can be stepped through by a configurable amount of 

frames for fine and course grained frame seeking. The << and >> 
buttons will skip the amount of frames forward/backward 
(respectively) as entered in the box directly to the right of the buttons. 

 
Time Properties Basic time based properties are viewable in the Movie Reel section, 

including the video In Point, Out Point, Duration and Frame Rate. 
These will be displayed as timecodes or frame numbers depending on 
the current Scanning Mode selected in the View menu. 
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Using Locators 

Locators are frame/timecode reference/labels available to the user. Locators can be added from a 
.qcml file, an EEG Scout file (.lctr), a Scout profile, or manually by the user. A locator includes a 
frame number/timecode, a label (optional), and an option to include the frame as a thumbnail 
image in the output report. If a locator label is included the label will show up in red under the 
frame in the Video Frame Viewer. 
 

 
Figure 13: Locators 

 
 

Add/Remove Locators A new locator can be added by clicking the “+” button under the 
locator list. This will bring up the dialog shown in Figure 14. In this 
dialog a timecode or frame number must be selected for the new 
locator to add. These fields will be auto-populated with the current 
frame/timecode. A text label can be entered in the “Locator Text” 
field or left blank if desired. The “Include Caption in Report” 
checkbox can be selected if a thumbnail of the locator is required 
for the output report (when generated). Once added, a locater can 
be removed by selecting it and clicking the “-“ button. Locator text 
can be edited by selecting the locator and right-clicking 
“Add/Modify Text.” 

 
 

 
Figure 14: Locators 
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Jump/Step Through Locators Double clicking a locator in the list will automatically jump to 

that frame. Locators can be stepped through backwards and 
forwards using the < and > buttons, respectively. The first and 
last locators can be jumped to directly by clicking the << and 
>> buttons, respectively. 

 
Duration Between Locators The duration between two locators can be acquired by 

selecting two locators in the list and right clicking “Get 
Duration.” This will prompt a box to appear containing the 
duration information in terms of frame number and 
timecode difference. 

 
 

 
Figure 15: Duration Between Locators Pop-Up Window 
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Audio Waveform Viewing 
 

 

The Audio Waveform Viewer allows the display of any channel of audio in the AS-02 bundle as a 
left and right audio waveform on a timeline, as seen in Figure 16. The audio can also be set to a 
configurable scrub. 
 

 
Figure 16: Audio Viewing Tools 

 
 
 

Waveform 

The audio waveform for the selected channel is shown in Figure 17. The display contains a visual 
representation of the left (blue) and right (red) audio waveform for that channel. The waveform 
length corresponds with the frames in the Video Frame Viewer. The audio waveforms scroll with 
the video. The +/- buttons in the lower right hand corner of the audio waveform viewer can be 
used to increase/decrease the vertical size of the waveforms. This can be helpful if a waveform 
with a low amplitude needs to be viewed in greater detail. 
 

 
Figure 17: Audio Waveform 
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Scrub 

The audio scrub can be turned on/off by the control shown in Figure 18. When enabled, audio will 
be played for a configurable amount of frames whenever a new frame is loaded (starting at the 
newly loaded frame). The configurable frame length is also shown in Figure 18. 
Note: A large frame scrub size may cause a decrease in performance. 
 

  
Figure 18: Audio Scrub 

 
 

Audio Tracks 

All audio tracks present in the loaded bundle can be selected for viewing/scrubbing via a drop down 
menu shown in Figure 19. 
 

 
Figure 19: Audio Tracks 
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Message Panel 
 

 

The Message Panel, as seen in Figure 20, displays a list of messages for Scout. Most commonly these 
message are profile analysis errors. Each message has a corresponding file, timecode, and reference 
(when applicable). Double clicking a message will take a relevant action to display more information 
about the error (i.e. double clicking an error in the manifest file will load the manifest file into the 
Bundle Explorer). 
 

 
Figure 20: Message Panel 
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Loading Profiles 
 

 

Profiles can be configured by the user to include specific tests and test options. This allows a 
customized analysis of each bundle based on a set of criteria. The Profile window shown in Figure 
21 pops up once a bundle has been loaded. A profile from the list can be selected and run by clicking 
Continue or the window can be closed if no profile is required for the bundle. A profile can also be 
loaded anytime from the File menu at the top. 
 
Profiles will include a set of tests with customized options and a set of locators. 
 
 

 
Figure 21: Profile Window 
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Profile List 

The profile list is shown in Figure 22. New profiles can be created and added to this list. Profiles can 
also be imported to this list from an EEG Scout Profile file (.insp). Existing profiles can be saved, 
exported, and deleted. 
 

 
Figure 22: Profile Selection and Options 

 
 

New/Copy Creates a new profile. The option is provided to copy the settings from a 
pre-existing profile as a timesaving feature. 

 
Save Saves an edits to the selected profile. 
 
Delete Deletes the selected profile. 
 

Export Exports the profile to an EEG Scout Profile file (.insp). This file can then be 
used to import the profile to another machine. 

 
Import Imports a profile from an EEG Scout Profile file (.insp). 
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Tests 

Each profile selected has a set of tests which can independently be selected for inclusion in the 
profile. Some of these tests have properties which are user configurable, as shown in Figure 23. 

 

  
Figure 22: Profile Selection and Options 

 
 

Locators 

Locators can be saved to the current profile as discussed on Page 14. Once locators are saved to a 
profile they will be loaded automatically with that profile every time it is used. 
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Output Reports 
 

The EEG FilePro Scout report includes basic bundle video/audio information, profile information, 
profile test results, locators, and frame captures. You can export this report to either an XML or 
PDF by selecting Export Results in the File menu. 
 
The report begins with the date/time it was created, as well as the bundle and profile name it was 
created for. The following video/audio properties are included. 
 

 Frame Rate 
 

 Scan Format 
 

 Aspect Ratio 
 

 Color Space 
 
 Chroma Sub-Sampling 

 
 Video Component Bit Depth 

 
 Video Average Bit Rate per Frame 

 
 Video Peak Bit Rate per Frame 

 
 Video Codec 

 
 Audio Track Count 

 
 Audio Channel Count (per track) 

 
 Audio Sampling Rate 

 
 Audio Bit Depth 

 
 VANC Data (type/location) 

 
Next, each test is listed with a pass/fail as well as details about each error detected (if any). A locator 
list is next, with each entry containing the locator’s timecode, frame number and label. Any locators 
selected to capture, as well as any frames captured manually during user inspection, are included 
at the end of the report. 
 

Exporting Report to XML 

For reports exported in XML format - Image capture thumbnails will be placed in a folder titled 
bundle-name_files. 
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Exporting Report to PDF 

For reports exported in PDF format - Image capture thumbnails are included as embedded inline 
graphics in the report. 
 


